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INITIAL METATRADER SETUP 

Section 1. First Steps. 
If you want the DeltaRiver work correctly, it is necessary that you have the MetaTrader terminal 

installed on your PC. It is possible to work with both MetaTrader4 and MetaTrader5. The difference is that in 
MT4 there is no way to import quotes history into DeltaRiver, and in MT5 there is such a possibility. 
Therefore, the use of MT5 with DeltaRiver is preferable, and MT5 is used later in this manual.  

Initial MetaTrader Setup 
To transfer data from MetaTrader to DeltaRiver correctly, you need to change the following settings: 

1) Go to the menu: Tools> Options 

 

2) In the options, go to the “Expert Advisors” tab and select the checkboxes “Allow automated trading” and 
“Allow DLL imports”.  

 
Now your terminal is ready to install the adviser.  
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DELTARIVER INSTALLATION 

 

DeltaRiver Installation 
1. Download the latest version from here - https://deltariver.pro/download/ 

 

 
2. Unzip the downloaded archive. To do this, click RMB on the archive and select "Extract to ... "

 

  

https://deltariver.pro/download/
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DELTARIVER INSTALLATION 

3. In the folder with the unzipped files, run the setup.exe 

 

4.1  In the installation window:  
1) Select the folder where DeltaRiver will be installed.  
2) Insert the path for the MetaTrader 4 terminal data directory in this field, if you want to use DeltaRiver 

with this terminal. If you do not want to use MetaTrader 4 - leave the field empty.  
3) Insert the path for the MetaTrader 5 terminal data directory in this field, if you want to use DeltaRiver 

with this terminal. If you do not want to use MetaTrader 5 - leave the field empty.  
4) Here you need to select the version of MetaTrader5 that you have installed. (Same as your Windows 

architecture)  
5) Press the button “Install” 

 
4.2 In order to determine the path of the data directory in MetaTrader  
4.2.1 In the MetaTrader terminal, in the “File” menu, select the item “Open data folder”  

 
 

4.2.2 Copy the path to the directory In the window that opens. Important: if there are Cyrillic characters in the 
path, it is necessary that when you copy the text, the keyboard layout is turned on in Russian, otherwise 
instead of the Cyrillic alphabet in the path, question marks are copied.  
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DELTARIVER INSTALLATION 

 
4.2.3 Paste in the appropriate field in the installation window.  

 

Now the terminal is ready for work.  
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CONNECTION OF A STANDARD SYMBOL ON THE EXAMPLE OF EURUSD 

Connection of a standard symbol on the example of EURUSD 
 

1. Launch MetaTrader. Check if you have an advisor (connector) installed for DeltaRiver. 
To do this, look at the “Navigator” panel (by default it is on the left, but if it is not there, turn it on in the 
View> Navigator panel or by pressing Ctrl + N). Expand the “expert advisors” tab and make sure that 
RiverClient is present in the list of advisors. If it is in the list, then go directly to step 3, if not, then go to step 
2. 
 

 
2. If the adviser (connector) is missing, do the following:  

2.1 In the MetaTrader terminal, click the “File” menu, then select the “open data folder” item  

 
2.2 In the window that appears, go to the MQL5 folder (or MQL4 if you have MT4 terminal) / Experts 
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CONNECTION OF A STANDARD SYMBOL ON THE EXAMPLE OF EURUSD 

 

 

2.3 For your convenience, create the DeltaRiver folder in the Experts folder 

 
2.4 Copy the corresponding adviser (connector) to the created folder.  

Connectors are located: 

- <DeltaRiver installation path>\Connectors\Forex\MT4\RiveRClient.ex4 (for MetaTrader 4) 

- <DeltaRiver installation path>\Connectors\Forex\MT5\RiveRClient.ex5 (for MetaTrader 5, 64-bit version) 

- <DeltaRiver installation path>\Connectors\Forex\MT5\RiveRClient32.ex5 (for MetaTrader 5, 32-bit version) 

 
2.5 In the MetaTrader terminal in the “Navigator” window, right-click on “Expert Advisers” and select 

“Refresh”  
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CONNECTION OF A STANDARD SYMBOL ON THE EXAMPLE OF EURUSD 

 
2.6 After that, the folder you created with the RiverClient adviser should appear in the “ Expert Advisers”. 

The above steps 2.1-2.6 are done only once.  
3. In the MetaTrader terminal in the market overview window, select the pair we need (in our example, 

EURUSD). Click on it with RMB and select "Chart Window".  

 
4. On this chart window, attach the RiverClient Expert Advisor by double-clicking or dragging onto the chart. 

It is preferable to connect the connector manually (by double-clicking or dragging to the chart), because 
loading a template (with an adviser) is not always successful. 

5.  In the window that appears, on the “Common” tab, check “Allow automated trading”.  

 
6. On the “Inputs” tab, configure the following parameters, according to your broker: 

Weekend trade - Asset trading on weekends. 
Real Volume - Use of real volumes in the DR (if the broker provides) futures, stocks, etc. 
Broker Timezone offset - broker's time zone in MT (in 99% of cases you do not need to touch - just leave 
Auto) 
TypeFillingForOrder - Broker order execution mode (in 99% of cases you don’t need to touch it - just leave 
ORDER_FILLING_FOK 

 
7. Click OK 
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CONNECTION OF A STANDARD SYMBOL ON THE EXAMPLE OF EURUSD 

8. After adding the expert adviser, check that this button is pressed . If everything was done 
correctly, an inscription will appear in the upper right corner , the timeframe will change to M1 

and in the upper left corner there will be an inscription  
Do not touch this chart at all anymore, if you need to do analysis on this pair, just open another chart.  
 

9. Launch DeltaRiver (If it has not already been started) 
10. In the DeltaRiver Menu, select "Add / Remove Symbol" → "Forex" → "EURUSD" 

 
11. After that, a tab with a currency pair will appear in the DeltaRiver window next to the main menu. And if all 

is well, then a green indicator will appear next to the name of the pair.  

 
In the MetaTrader terminal, in the window with the chart of this currency pair, the inscription will appear:  

 
12. DeltaRiver terminal is ready for further work now.  
13. If you need to close the symbol chart in DeltaRiver, then in the Menu, select again "Add / Remove Symbol" 

→ "Forex" → Symbol  
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CONNECTING A CUSTOM CHARACTER USING THE NASDAQ 100 INDEX AS AN EXAMPLE. 

Connecting a custom character using the Nasdaq 100 index as an example. 
1. In the MetaTrader terminal, in the market overview window, select the index you are interested in (in our 

example, it is NQ100). Click on it with RMB and select "Chart Window".  

 
2. Double-click on the RiverClient Expert Advisor on this chart window, or simply drag it onto the chart. 

The best way to connect the connector is manually (by double-clicking or dragging onto the chart), 
because loading a template (with an adviser) is not always successful. 

3. In the window that appears, on the “Common” tab, check “Allow automatic trading”.  

 
4. On the “Inputs” tab, configure the following parameters according to your broker: 

Weekend trade - Asset trading on weekends. 
Real Volume - Use of real volumes in the DR (if the broker provides) futures, stocks, etc. 
Broker Timezone offset - broker's time zone in MT (in 99% of cases you do not need to touch, leave Auto) 
TypeFillingForOrder - The mode of execution of orders by the broker (in 99% of cases you do not need to 
touch, leave ORDER_FILLING_FOK 

 
5. Click «ОК» 

6. After adding the expert adviser, check that the button  has been pressed. If everything is 
done, then in the upper right corner an inscription will appear , the timeframe will change to M1 

and in the upper left corner there will be an inscription  
Do not touch this chart at all anymore, if you need to do analysis on this pair, then open another chart.  
 

7. Launch DeltaRiver (If it is not already running) 



 

SECTION 1. FIRST STEPS.          13     
 

CONNECTING A CUSTOM CHARACTER USING THE NASDAQ 100 INDEX AS AN EXAMPLE. 

8. In the DeltaRiver Menu, select "Add / Remove Symbol" → "Forex" → "Add Your symbol ..." (Almost at the 
very bottom of the list)  

 
9. In the window that appears, enter the name of the ticket. Just as it is written in parentheses in step 6 (In our 

case, the NQ100)  

 
10. After that, a tab with a currency pair will appear in the DeltaRiver window next to the main menu. If all is 

well, a green indicator will appear next to the name of the pair.  

 
In the MetaTrader terminal, in the window with the chart of this currency pair, the inscription:  

 
11. DeltaRiver terminal is ready for further work.  
12. If you need to close the symbol chart in DeltaRiver, then in the Menu, select "Add / Remove Symbol" → 

"Forex" → Symbol 
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TOOLBAR. 

Section 2. The program interface. 
Toolbar.  

 

 
1. The main menu button 

Pressing this button opens the following menu:  

 

1.1 “Add / Remove Character” is a sub-item that allows you to add or remove characters from DeltaRiver. To 
add characters, see here и here.  

1.2 “Notifications”- opens the notification settings window.  

 
1.2.1 Button to switch from notification options to notifications themselves.  
1.2.2 Button to close the notification window 
1.2.3 Previous notice 
1.2.4 Next Notice 
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TOOLBAR. 

1.2.5 If the checkmark is on, there will be no pop-up window, there will only be sound.  
1.2.6 Time after which the notification window is hidden when inactive.  
1.2.7 Select the default notification sound. First you need to drop the .wav file in 

<DeltaRiver installation path>\sounds\\ 
1.2.8 Choosing your own notification sound for each pair. If a sound is not selected for any pair, there will be a 

default sound.  
1.3 “Enter Intrade.bar ...” - opens a window for authorization with the broker intrade.bar. You must first be 

registered with this broker.  

 
1.3.1 “Email” - enter the email address to which you registered on intrade.bar in this field 
1.3.2 “Password” - enter the password that you use to enter intrade.bar in this field 
1.3.3 With the checkmark turned on, at startup, DeltaRiver will automatically connect to intrade.bar.  
1.3.4 With the checkmark turned on - DeltaRiver saves your password from intrade.bar 
1.3.5 “Login” - after the entered data, the DeltaRiver connects to intrade.bar. 

If the password / login is incorrect, a window will appear informing you of this. 

: 
1.3.6 “Close” - closes this window. Moreover, if the data is entered for the first time, they will not be saved.  

All changes will be discarded.  
1.4 Choice of interface languages. Two languages to choose from - Russian and English.  
1.5 “Help” - opens the manual that you are reading now and is located in  

<DeltaRiver installation path> \ DeltaRiver_Manual.pdf 
1.6 Links to the DeltaRiver community on various social networks. 
1.7 "Exit" - closes the application.  

  



 

SECTION 2. THE PROGRAM INTERFACE.          16     
 

TOOLBAR. 

2. MultiView mode. 
MultiView mode allows you to select and simultaneously see three different timeframes of one pair.  

MultiView 

 
 

Standard chart display 

 

Managing Charts in MultiView 

1. Double click on the chart - “opens” the chart, by clicking on which the full window is displayed in standard 
display. Another double click - returns MultiView mode.  

2. Dragging the separator - changes the proportions of the graph in random order 
3. Double click on the vertical divider - the proportion changes in the following order – 50%/50% -> 30%/70% -> 

25%/75% -> 20%/80% -> back 50%/50% 
4. Single right click on the vertical divider - changes the proportion immediately to 20%/80% 
5. Double-clicking on the horizontal divider returns the proportion 50%/50% 

P.S. Separators are gray bars between charts.  

P.P.S The vertical separator is the one directed like this |. Horizontal like this ―. 
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3. Timeframe selection 
 

Click on the “Period” window and see a drop-down menu with options for choosing TF 

Unlike MT4 / MT5 terminals, DeltaRiver has a significantly wider range of timeframes. 

In order to select the required timeframe, simply click on it with the left mouse button and it will 
automatically apply to the current chart 

You can also switch the timeframe using hotkeys: 

F1..F10 – Timeframe M1..H1 

Ctrl+F1..F6 - Timeframe H2..H12 

 

 

 

 

4. Multiplier Setting 

 

 

The multiplier setting menu allows you to select the required coefficient for displaying clusters in DeltaRiver. The 
multiplier coefficient ranges from x0.1 to x100 

If you click on the “Multiplier” button, a window appears in which using the slider you can select the desired ratio. 
The coefficient is selected using:  

- dragging the slider 

- left / right arrows 

- mouse wheel.   

After selecting the required value, click on the "Apply" button 

You can also switch the multiplier using hot keys: 

+ / - (on the optional keyboard) - increases / decreases the multiplier 

 

What is a “Multiplier”? 

A cluster is a “collection” of all trades in the range of 10 pips, for example, a cluster at a price level of 1.2362 includes 
all transactions that have passed in the range of 1.23620-1.23629 

And the "Multiplier" increases this range, i.e. with a multiplier of x2, the cluster will consist of 20 pips (range 1.23620-
1.23639), or reduces this range when choosing a multiplier in the range x0.1-x0.9. Thus, with the multiplier x0.5, the 
cluster will consist of 5 pips, with the multiplier x0.7 - of seven, etc. 
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5. Cluster selection modes 
This menu allows you to select the desired option for displaying clusters in DeltaRiver. 

 

  

1 2 3 4 5 6 
 

This menu has the following modes: 

1 - Volume Full - shows the total amount of Purchases and Sales in the cluster 

2 - Volume of buy / Sell - shows separately Purchases and Sales 

3 - Delta - shows the difference between purchases and sales (Delta = Purchases - Sales). The difference is either 
absolute, i.e. without negative values, or with negative values (if the corresponding item in the Options is selected) 

4 - Volume Full + Balance - shows the total amount of Purchases and Sales, as well as a histogram showing the 
strength of buyers and sellers in a cluster. 

5 - Volume Full / Delta - shows the total amount of Purchases and Sales in the cluster against the background, Delta 
in the foreground 

6 - Volume Full + Delta - shows separately the total amount of Purchases and Sales in the cluster and Delta 

You can also switch cluster mode using hotkeys: 

0 (on additional keyboard) - Volume Full 

1 (on additional keyboard) - Volume of buy / Sell 

2 (on additional keyboard) - Volume Delta 

3 (on additional keyboard) - Volume Full + Balance 

4 (on additional keyboard) - Volume Full / Delta 

5 (on additional keyboard) - Volume Full + Delta 
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6.  Display settings for the "News" block  
The News button allows you to enable the display of the News block in the 
DeltaRiver main window. 

When you click on the gray dot of the button, the "News" block is turned on 
/ off 

When you click on the arrow to the right, a menu opens where you can 
configure the news block. 

In this menu you can choose which news to display: 

all news of the day, or by symbol, the importance of news by the number of 
stars, as well as an additional option to hide past news, with the ability to 
set the time interval 

 

7.  Auto Scroll and Current Scroll Buttons. 
 

The “Auto Scroll” button allows you to enable / disable the automatic scrolling of the chart as the price moves. 

The button “Scrolling at the moment” allows you to instantly go to the most recently formed bar. 

If you want to calmly navigate through the history of the chart, for example, when performing an analysis, uncheck 
“Auto scroll”, otherwise the chart will constantly move to the last bar. 

 

8.  Vertical autoscaling.  
 

The vertical auto-scaling mode reduces the cluster size vertically, allowing you to display a portion of the chart in full 
from High to Low prices.  

LMB click on the icon - autoscaling using the multiplier 

RMB click on the icon - autoscaling within the current multiplier.  

9. Color customization for custom (user) levels. 
 

The Levels panel allows you to select a color for your future 
level on the chart 

 

 

 

 

 

There is also an additional palette for “custom” colors, which 
will be displayed in the corresponding items of the context 
menu (“Set User Level”, “Set User Level from” and “Set User Zone from”). 
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TOOLBAR. 

 

After you have selected the color, click OK, then find the level you need on the price scale and click on it with the 
Right mouse button. 

 

Right-click on the level again to remove it. 

 

Initially, when you create a level, its name is the timeframe on which you placed this level. if you want, you can 
change this name. To do this, double-click on the level name, and in the window that appears, enter a new level 
name, then click "OK".  
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10. Download tick history from MT5 terminal. 
If Delta River is connected to the MT5 terminal, then the “Download tick history” button becomes active and makes 
it possible to upload a tick history to Delta River for 
the selected period. 

Loaded history is displayed in yellow columns (1) 

A plot without history is displayed without yellow 
columns (2) 

To select the beginning of the period, drag the 
slider (4) and click the "Start date" button 

To select the end of the period, drag the slider (4)  
and click the "End date" button 

The selected period is marked in green in the 
history information field below (3) 

On the right above the “Download” button, the 
approximate loading time of the history of the selected period is displayed in the format of minutes: seconds 

After the period is selected, click the "Download" button, and the tick history from MT5 starts downloading, showing 
the progress. 

You can also clear the selected section of the history by clicking the "Clear" button. At the same time, the selection 
of the plot of history is also done using the slider and the buttons "Start date" and "End date"  

 

You can download the tick history with preliminary cleaning in DeltaRiver, for this you need to put a tick “with 
cleaning” (on the left above the “Download” button) 

Also at the top of the window there are seven preset buttons for the start date period. After selecting / clicking on 
them, you need to click on the "Download" button 

You can download tick history by downloading quotes file (via the Import button), after creating the file in MT5 
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1 - Open the window symbols 

2 - Go to the Ticks tab 

3 - Choose a currency pair 

4 - Set the history period for export 

5 - Click the "Request" button 

6 - After downloading the tick history of 
quotes for the specified period, click the 
“Export ticks” button and select where to save 
the file, which can then be downloaded using 
the Import button (in Delta River) 

  



 

SECTION 2. THE PROGRAM INTERFACE.          23     
 

TOOLBAR. 

11. "Editor" menu for inserting graphic elements on the chart.  
 

When you click on the gray dot of the button, the display 
of graphic elements on the chart is turned on / off. 

Clicking on the arrow on the right opens the graphical 
editor panel. 

 

In this menu, you can create graphical objects (linked to 
price and time) on the Delta River graph of the following 
type: 

- arrow 

- line 

- Rectangle (transparent / filled) 

- Ellipse 

- Text 

 

You can also choose the size, color, and transparency for 
each of the objects 

 

In addition to creation, objects can also be deleted - for 
this there is a button “Delete Object” in the form of an 
eraser on the toolbar. 

 

In order to delete an object, it is necessary to select it in the list of objects, and then click "Delete Object" 

 

You can also delete an object using the Del button; if you want to clear the entire list of objects, then Ctrl + Del 

 

Double click or Enter on an object in the list allows you to change the name of the object 
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12. Creating a screenshot of the chart.  
 

The “Take screenshot” button creates a screenshot of the current chart and saves it to a file of the following type 

<DeltaRiver installation path> \ screenshots \ screenshot_ <Character> _ <date> _ <time> .jpg 

if you click LMB on the screenshot icon, then a screenshot of the current chart 

if you click RMB when MultiView mode is on, then all three windows with charts, if MultiView is off, then just one 
current chart. 

When creating a screenshot, it indicates: 

Currency pair, timeframe, multiplier and type of displayed volume.  

Example screenshot in MultiView mode. 

 

Example screenshot in single chart display mode.  
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13. The mode "Out of the main window."  

When you click "Mode outside the main window"  All pairs of tabs open in separate windows, allowing you to 
manipulate them as you wish. Additional buttons appear.  

 

1. «“Mode inside the main window” - returns the standard display of charts in the form of tabs. 
2. “Arrange mosaic” - disposes all the charts on the same screen as “mosaic”. 

Charts layout examples:  
Two charts: 

 

Four charts: 
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Six charts:  

 
 

3. “Arrange one after another” - In this mode, windows with graphs are located one below the other over the 
entire width of the window. 

4. "Show all windows" - if the windows are lost under the windows of other programs - this button will bring all 
the windows with graphs to the foreground. 

5. “On top of all windows” - fixes the top panel in the “on top of all windows” position.  

14.  Cumulative history loading for all open currency pairs.  

If you click the  "Get History for the Last N Hours" button, a list with predefined history 
dates opens. Selecting one of the values will load the history for all open pairs. A progress bar 
appears with an approximate end time for downloading in the format MM:CC 

 

In this case, further work with pairs will be impossible until the history is loaded.  
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Section 3. Trading panel. 
 

DeltaRiver is equipped with a full-fledged trading panel for both Forex and the binary options broker intrade.bar, so 
in order to analyze and open a deal, you do not have to switch between in MT4 / 5 and back (or between the 
browser and back, in case of trading BO ) You can open a deal directly in the DeltaRiver (provided that the adviser 
has permission to trade (more here and here), or you entered the intrade.bar in the case of BO trading (how to enter 
the intrade.bar in DeltaRiver was shown here)) The trading panel mode switch is located in the upper right corner of 

the window and looks like this . 

 

 

In order to get into the trading panel, look for a gray bar on the right side of the window, with a 
small arrow in the middle. This whole strip is clickable. To open the trading panel, you must click 
on this strip.  

 

Pressing the strip again hides the trading panel  
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Forex mode. Panel Description. 
The trading panel consists of the following blocks: 

 

The first block is the Sell & Buy buttons, 

allows you to open relevant market transactions 

 

The second block is the volume of the order, 

allows you to set the necessary lot size for the order 

It is also possible to set the calculation of the lot size of the order of the amount 
of risk (percentage of the balance) 

 

The third block is the “Stop-loss” menu, 

allows you to set the necessary settings for your Stop-Loss order 

 

The fourth block is the Take Profit Menu, 

allows you to set the necessary settings for your Take-profit order 

 

The fifth block - List of open orders 

Displays available open orders with real-time display of current profit / loss, as 
well as with the ability to change some conditions of the order, or close the Full / 
Half order 

 

The sixth block - History of executed orders 
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Forex mode. Setting the “Stop-Loss” Menu  
- put on the broker’s server 

It is possible to enable / disable this feature. It is necessary in order to hide the 
location of your Stop-loss order for your broker, in order not to become a victim 
of an increase of the spread or manipulations from DC 

 

- from price order (pips) 

This field indicates the distance in pips at which Stop Loss should be set 

 

- at the nearest level 

Setting a Stop Loss order for the User Level or Auto Level closest to the entry point 

- Transfer to break-even if the price exceeds the order price (pips) 

This field indicates the distance in pips, upon reaching which the Stop-loss order will be moved to breakeven 

- Trailing stop from the current price (pips) 

In this field, you can enable the Stop Loss Order following the price. You only need to indicate at what distance in 
pips the order needs to follow the price 
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Forex mode. Setting the “Take-Profit” menu  
 

- put on the broker’s server 

It is possible to enable / disable this feature. It is necessary in order to hide 
the location of your Take-Profit order for your broker, in order not to 
become a victim of an increase of the spread or manipulations from DC 

 

- from price order (pips) 

This field indicates the distance in pips at which Take-Profit should be set 

- from Stop-loss 1 to 

In this field, you can set the desired ratio for setting Take Profit orders in relation to the Stop Loss order 

- Safe 

This is a partial profit fixation system. For example, “TP / 2 - 50%” with an order volume of 1.0 means that “on the 
way” to Take Profit exactly in the middle there will be a partial fix in the amount of 0.50, and the rest of 0.50 will 
close on the Take Profit order itself 

 

An example of one use case: 

- An order of 0.10, 

- Take profit of 100 pips (10 points) 

- breakeven - 50 pips 

- Safe «TP/2 – 50%» 

The price passed 50 pips, a partial fixation of 0.05 profit 
occurred and Stop-loss was moved to breakeven - even 
if the price goes against us, we still got half the profit. 

When you hover your mouse over the SELL or BUY 
button, the Stop Loss and Take Profit levels (with a 
digital value of loss and profit) are displayed on the 
chart in real time with the conditions and parameters 
specified in the trading panel 
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Forex mode. Open Order Management 
 

   In the list of open orders 
 

In the list of open orders, information for each order is displayed: 

- type of order BUY / SELL 

- date, price and size of an open order 

- breakeven and trailing stop conditions 

- condition of the Safe system 

- real-time profit / loss level of the order 

- there are also two buttons on the right: 

⊗ - close the entire order 

Ø - close half of the order 

 

 

Right-clicking on a List of open order opens a menu for changing parameters 

 

In this menu you can change the following parameters: 

 

- distance in pips of the breakeven level 

 

- distance in pips of the trailing-stop level 

 

- enable / disable "Safe", as well as change its conditions 

 

   On the chart 
 

On the price scale, using the Left mouse click and drag, it is possible to change the Stop Loss and Take Profit levels 

If the Stop Loss and Take Profit levels are not set, then they can be set using the Left mouse button on the price of 
the order and drag: 

- up for a BUY order - Take Profit  On the price scale Right-click on the price 

- down for a BUY order - Stop Loss   Orders - closes an order 

- up for the SELL order - Stop Loss   Stop Loss - removes a Stop Loss Order 

- down for a SELL order - Take Profit   Take Profit - removes Take Profit Order 
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BO mode. Panel Description. 
 

The trading panel consists of the following blocks:    

 

The first block – volume of order, allows you to set the required option size in 
the account currency.  

 

The second block is Choosing the type of options for intrade.bar. You can 
choose either Classic options with expiration from 5 minutes and above. Or 
Sprint with expiration 3-4 minutes.  

 

Third block - Market execution of options. Put & Call buttons allow you to 
open options at the moment.  

P.S. Intrade.bar does not allow to open options in the first 5 minutes from 
16.59 Moscow time every hour. Accordingly, from 16.59 to 23.59 every hour 
in the time interval: hh-59 to hh-04 the Put & Call buttons are not active. 

You can read more about this in the Intrade.bar FAQ 

 

The fourth block - Limit order - allows you to set up “smart” pending orders 
that will open options when you reach a given level. In this case, options will 
open only if: 

For PUT option - if the price goes from top to bottom. 

For a CALL option - if the price goes from bottom to top. 

P.S. For the stable operation of this mode, a stable and high-quality Internet 
connection is required. Otherwise, slippage in the opening of options is 
possible.   

 

Fifth block is Current - List of open orders 

Displays available open orders with real-time display of current profit / loss. 

 

Sixth block - History of executed orders - at the same time it is possible to 
enable the display of closed options on the chart.  

  

https://intrade.bar/faq
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Section 4. The Options Window 
The main tab 
 In the left half there are settings, in the right half - an example of a chart display with these settings 

 

Chart Background - The color for the background. When you select the "Gradient" checkbox, the background color 
will change from top to bottom from light to dark 

 

Cursor color - color for the cursor. If black is selected (# 000), then automatic color mode is applied.  

 

Current Price (Bid) - color to display the Bid price 

Current price (Ask) - enable / disable and the color of the Ask-price display 

“Full” checkbox - when the checkbox is on - the price line is extended to the entire length of the chart, when 
disabled - only until the current bar.  

 

Cluster frame - the color of the cluster frame. If black is selected (# 000), then automatic color mode is applied.  

 

The color of the digital values in the cluster is the color of the numbers. If black is selected (# 000), then automatic 
color mode is applied.  

 

Color of volumes with a percentage scale of 25% -100% for purchases and sales (black color # 000 - transparent) 



 

SECTION 4. THE OPTIONS WINDOW          34     
 

THE MAIN TAB 

 

Cluster background - enable / disable and color selection to show the prevalence of purchases / sales. 

 

Bar body/shadow - enable / disable the display, as well as the choice of color and size for parts of the bar (black 
color # 000 - transparent)  

Candle by clusters - display candles in multiples of clusters 

 

Numeric values in clusters - enable / disable the display of digital values in clusters 

 

Negative Delta value - enable / disable the display of negative Delta in the “Delta Volume” mode 

 

Graphical display of the amount of volume - enable / disable the display of volume by a histogram in the cluster 

  
Arrow assistant - enable / disable assistant marking type of candle.  

  – slightly pushing 

  – pushing 

 – slowing down 

  – braking 
Always consider that the arrows are displayed on the candles that are passed - this does not mean that the next 
candle will go in this direction in 100% of cases, but the probability of this increases. 

 

Candle timer - select the display location: on the current bar (on the timeline) or under the Bid price 
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Grid Contrast - displays on the chart lines of hourly and round price levels 

 

“Time (grid)” and “Price (grid)” ticks - enable / disable the grid at hourly and round levels at a price.  

 

Number of candles for rendering (cache) - this parameter controls the depth of rendering of clusters. At the initial 
opening, the entered number of candles is drawn. Further, if more candles are needed, you need to scroll to an 
empty area on the chart, and DeltaRiver will automatically load an additional number of candles equal to the cache. 

For convenient use, cache values must be set to the number of candles that are placed a width of one and a half to 
two screens.  

Cluster Display Features  
The percentage scale of 25% -100%, as well as a graphical display of the amount of volume is calculated from the 
maximum cluster volume of the plot section, which is visible. 

In the example below, we see that at the maximum volume, a graphic display of the volume paints the cluster over 
the entire width.  
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If you zoom in a little, thereby expanding the visible portion of the chart, you will see the following: 

The previous maximum has ceased to be the maximum of the visible region, and accordingly the scale has not 
already been painted over to the full width of the cluster.  

 

In DeltaRiver, the display of color in a cluster for “Color of volumes” and “Cluster background” is due to the 
predominance of Buys or Sales.  

         

For example, if the “Volume Full” mode is selected and the cluster has “passed” 45 Buys and 44 Sales, then the 
number 89 will be displayed, and the color will be selected as for Buys, because Buys prevail (in this case, the shade 
of green)  
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Indicators  
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

A list of indicators is displayed on the left. Each indicator can be turned on / off by clicking on the gray dot to the left 
of its name 

When you click on an indicator, its parameters are displayed in the right half. 

If the “MultiView” mode is used, note that the upper block of indicators will be used for the current chart, and in the 
case of the “Custom Filter” indicator, for the current timeframe. 

 

Maximum volume in the bar  
 

 

Allows you to enable / disable the highlighting of the cluster (the cluster with the maximum volume is highlighted 
with a frame) containing the maximum volume in this bar (does not contain parameters).  
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Volumes by time (vertical) 
 

 

The choice of color for Buys / Sales / Equal (in the prevailing mode) or General (in other cases) 

Type of vertical volume: 

Full volume - with a predominance of Buys or Sales 

 

Divide Buy/Sell - the histogram displays the strength of both buyers (up) and sellers (down)  

(the full volume is displayed on the background)

 

Delta - a histogram displays the difference between buyers and sellers  

(the full volume is displayed on the background)
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Additionally there are options (enable / disable): 

- display of digital volumes 

- for general dimming of the entire histogram, if the total volume is less than 50% 

- highlighting the brightness of the prevalence of buys or sales 

Additionally, you can configure the “Divergence” parameter - the difference between the prevalence of volume and 
“direction” in one candle, for example, a bearish candle, i.e. the price goes down, and the vertical volumes of the 
candle say that buys prevail in it. This value is used in Notifications in the "Divergence" parameter. 

The last block consists of two parameters and relates to finding and displaying Divergence on 2 or more candles 
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Volumes by price (profile)  

 

The choice of color for Purchases / Sales / Equal (in the prevailing mode) or General (in other cases) 

Type of horizontal volume: 

1.Full volume - display only the full volume 

2. Divide Buy/Sell - the histogram reflects the strength of both buyers (to the right) and sellers (to the left)  

(the full volume is displayed on the background) 

3. Delta - the histogram shows the difference between buyers and sellers  

(the full volume is displayed on the background) 

4.upSELL/dnBUY - a mode in which volumes of past transactions above the current price are shown for sale. 
Volumes of past buy transactions are shown below the current price. 

(full volume is displayed on the background) 

1 2 3 4 
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Additionally there are options (enable / disable): 

- display of digital volumes 

- for general dimming of the entire histogram, if the total volume is less than 50% 

- highlighting the brightness of the prevalence of buys or sales 

 

- “Volumes by the latest values” - in this calculation, only the cluster volume that was not blocked by the next bar is 
considered and displayed 

In the screenshot below, everything that is not in the yellow zone will be considered in the volume 

 

Number of hours for profile calculation - used both for calculating the horizontal profile and displaying the depth of 
the history of bars 

Also, on the profile are three “Control Points” 

POC-F - for the entire period 

POC-W - per week 

POC-D - per day 

with the prevailing color of Purchases or Sales at this level 

 

Below the profile are three buttons that switch the profile display 
mode. 

F - for the entire period 

W - from the beginning of the week 

D - from the beginning of the day 

 

You can switch the display mode using the hot key Ctrl + F11 
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Custom Volume Filter 
 

 

Custom Volume Filter indicator allows you to flexibly configure filtering and displaying clusters on a chart using a 
large number of conditions. 

At the top of the parameter block is a list of filters that you have already added. 

To create a new filter, set all the parameters and click the "Add" button - it will immediately appear in the top list. 

To edit an existing one, click on the filter in the list, change the parameters and click the "Update" button. 

To delete, click on the appropriate filter in the list and click the "Delete" button. 

 For each filter, there is a “value” and five types of conditions: 

1. The volume is taken from the cluster, depending on the type of this value  
 
 
 
 
 
 
 

2. Compare "> =" (greater than or equal to) or "<=" (less than or equal to) with the 
specified value  
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3. Then, the condition for finding this cluster is compared; in the first option, the 

condition is absent (no)  
 
 
 
 
 
 
 
 
 
 
 

4. Then, the type of bar in which this cluster is located is compared; in the first option, 
the condition is absent (no) 
 

 

 
 
 

5.  The last condition is a comparison of the time of the bar 
in which this cluster is located. The parameters indicate 
the period of time for the condition. In this case, the 
value indicates a time span equal to a full hour. Thus, for a value of 0, the test condition is from 0.00 to 0.59, 
similarly for all the others. Accordingly, for the range 0-23 hours, the time interval is 0.00 - 23.59.   

If all conditions are met, then the cluster is painted in the specified color 

 

In order to make it easier to analyze and indicate the values, at the 
bottom of the parameters there is an information block with graphs of the 
distribution of cluster volumes - Full, Buy and Sell. There is also a 
parameter to limit the time period of the received volumes. 

After clicking the “Get info” button, it is filled automatically 
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 You can also copy filters from another timeframe, using the 
timeframe list located at the top of the parameter block, 
above the filter list.  

If “---” is displayed in the list opposite the timeframe, then 
there are no filters on this timeframe 

The “<” icon means the current timeframe (you are 
currently changing the parameters of this timeframe) 

 

Important! When copying, both conditions and values are 
transferred; accordingly, after copying, you should edit the 
values for the current timeframe 
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Local Range  

 

Based on the volumes, an approximate current horizontal price corridor is calculated, according to the type of local 
levels (does not contain parameters) 

 

Local profile and cumulative delta 
 

This is how the local profile looks “stretched” in any arbitrary place 

 

When you hover over the Local profile, it becomes brighter 

- bright levels on the histogram show the maximum volumes for buys and sales (local Point of Control - POC), as well 
as VAH and VAL levels with lines to the end of the chart 

- the ratio and balance of the Buy / Sale of this site is indicated on the top of the Local profile frame 

- the overall color of the Local Profile frame shows the predominance of Buys or Sales 

- below the Local profile is the Cumulative Delta block, which displays the time variation of the cumulative delta of 
the selected section, as well as the information block on the left: C - the number of candles of this timeframe; D - 
Delta of this section (Buys minus Sales); V is the total volume of this section 

 

At the bottom right are: button X - close the block and next to the square - the switch of the display mode of the 
histogram of levels (Volumes / Delta) 

 

When you click the Left mouse button on the Local profile, the User level is automatically set at the price where the 
maximum total volume (local Point of Control), as well as VAH and VAL 
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To install the Local profile, do the following: 

- select the required period on the chart 

- clamp on the initial bar of the selected period 

     - Left mouse button + Shift (static) 

     - Left mouse button + Shift + Alt (rubber) 

     - Left mouse button + Shift + Ctrl (dynamic) 

- stretch the profile to the end of the selected period and release the buttons 

- to reset the profile - just click the Left mouse button + Shift on the timeline 

 

The rubber Local profile is the area in which when a new bar appears, it is added and, accordingly, the profile and 
cumulative delta are recalculated. 

Dynamic Local profile - this is a section that, when a new bar appears, the profile “moves” and, accordingly, the 
profile and cumulative delta are recalculated. 

 

When the Scroll-Lock button is on, you can pull the Free Local profile - without binding to the High / Low candles in 
the selected area. 

 

In the “Indicators” parameters window, you can adjust the colors for the indicator to display 

 



 

SECTION 4. THE OPTIONS WINDOW          47     
 

INDICATORS 

Zoner 

 

The Zoner indicator can be used both for marking Fibonacci levels and user levels. 

It works both in auto mode and can be manually “pulled” to an arbitrary section of the chart. 

At the top of the block are the settings for automatic mode. 
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Below are the buttons:  

 

Clear - cleans previously created levels 

Simple - creates levels with values: 0%; 12.5%; 25%; 50%; 75% 87.5%; 100% 

Fibo - creates Fibonacci retracement levels. 

Trinity - levels are created based on Tesla's numbers. 

Below is a list of levels, as well as buttons and options for creating / updating / deleting levels.  

 

The list contains all previously created levels. Each line in the list is a level. Each line displays the following options:  

1. Level color. 
2. Number in order. 
3. Percentage level. 
4. The thickness of the level line in pixels. 
5. Parameter staining zone. If “-” is set, then the parameter is not active for this level, if “X” is set, the 

parameter is active. 
6. Level name. If the name is not specified, the field will be empty.  

 It is also worth adding about the zone staining parameter.  

 

A zone is the space between the level at which you set this parameter 
and the level that is the previous percentage. In a specific example, the 
parameter is set at 50% and the staining area is between 50% and 
30%.  

 

 

To create a new level - set all the parameters and click the "Add" button - the level will immediately appear in the 
top list 

To edit an existing level, click on the level in the list, change the parameters and click the "Update" button 
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To delete a level, click on the corresponding level in the list and click the "Delete" button 

Control.  

Turn on / off auto mode - Ctrl + F9 

To manually “pull” Zoner you must do the following: 

- select the required period on the chart 

- hold the left mouse button + Ctrl on the initial bar of the selected period 

- stretch to the end of the selected period and release the buttons 

- to reset Zoner - you just need to click the Left mouse button + Ctrl on any one bar or press the key combination Ctrl 
+ F9 

ZigZag 

 

The ZigZag indicator connects extremum on the chart with a line, thus filtering minor price fluctuations. The 
significance of the extremum is regulated by the parameter “minimum wave size” - the minimum distance at a price 
between High and Low prices of one wave. 

Also makes it possible to display the height (distance at a price between High and Low prices), the traded volume 
and delta in a specific wave 
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Moving averages 

 

 

At the top of the parameter block is a list of moving averages that you have already added. 

In addition to the standard parameters in MT4 / MT5 (Close, Open, etc.), there are three additional parameters that 
are calculated based on volumes: 

- “Average” (Full volume) 

- “Average (Buys)” 

- “Average (Sells)” 

 

To create a new moving average, set all the necessary parameters and click the "Add" button - the moving average 
will immediately appear in the top list 

To edit an existing moving average, click on it in the list, change the parameters and click the "Update" button 

To delete a moving average, click on the moving average in the list that you want to delete and click the "Delete" 
button 
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Bollinger Bands 

 

In addition to the standard parameters for Bollinger Bands (Close, Open, etc.), there are three additional parameters 
that are calculated based on volumes: 

- “Average” (Full volume) 

- “Average (Buys)” 

- “Average (Sells)” 

The Deviation parameter may have a fractional part 

The Transparency parameter sets the degree of transparency of the indicator display on the chart. 
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Point of Control (auto levels) 

 

This indicator allows you to enable and set the display color of the "Point of Control" for a specific period 

Period M5 - in the last 5 minutes 

Period M10 - in the last 10 minutes 

... 

Period H4 - in the last 4 hours 

 

Also added the ability to display on the history the change of “Point of Control” with the corresponding option 
“Dynamic POC” 
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Big trades 

 

The BigTrades indicator helps to filter and display large deals on the chart according to the given values. 

In order to make it easier to analyze and indicate the volume, at the bottom of the parameters there is an 
information block with charts of the distribution of transaction volumes for Buys and Sells. 

It is filled after pressing the "Get info" button 

The values in the fields can be set either manually or by clicking on the corresponding distribution chart. 

 

The “Volume Aggregation” parameter is used to sum and display (scale) in a cluster more than one large (filtered) 
transaction. For example, if this parameter is set, then if there are two or more large deals in this cluster, the 
indicator circle above the cluster will be increased (scaled according to the total volume of all large deals) 

 

The “Transparency” parameter sets the degree of transparency of the indicator display on the chart. 
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CCI 

 

CCI - (Commodity Channel Index) is a technical indicator based on an analysis of the current change in the price 
deviation from its average value for a certain period and the average absolute value of this parameter. 

In this window you can adjust the color display of this indicator, and choose at what price the indicator will be 
calculated. 
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RSI 

 

RSI - (Relative Strength Index) - an indicator of technical analysis that determines the strength of a trend and the 
likelihood of a change in trend. 

In this window you can adjust the color display of this indicator, and choose at what price the indicator will be 
calculated. 
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Stochastic 

 

Stochastic Oscillator is an indicator of technical analysis that shows the position of the current price relative to the 
price range for a certain period in the past. Measured as a percentage. 

In this window you can adjust the color display of this indicator, and choose at what price the indicator will be 
calculated. 
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ATR 

 

ATR (Average True Range) is an indicator of market volatility. It was introduced by Wells Wilder in the book 'New 
Concepts of Technical Trading Systems' and since then the indicator has been used as a component of many other 
indicators and trading systems. 

In this window you can adjust the color display of this indicator, and choose at what price the indicator will be 
calculated. 
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Saving and Loading a Template 
 

All settings in the Options window can be saved / loaded into a separate file. 

In order to save the settings template, click the "Save Template" button, in the window that opens, specify the file 
name for the template or select an existing template (settings will be overwritten). 

After that, in a new window you can indicate your Authorship and your link (Telegram, facebook, etc.) 

The template file with the specified name (with the extension .tpl) is saved in the templates folder. 

To load settings from a template, the template file must be in the templates folder. 

Click the "Load Template" button, and in a new window, the list will display all those templates that are currently in 
the templates folder. 

After you have selected a template, you can check the boxes for each type of settings if they are present in the 
template (in the lower half of the window there is a list of settings for a specific template) 

 

These checkboxes can be turned on / off, and then when loading the template, only the settings that are ticked will 
be applied. 

If the checkbox for “Custom Volume Filter” is enabled, then the settings for this indicator will be loaded for all 
timeframes that are present in the template 

  



 

SECTION 4. THE OPTIONS WINDOW          59     
 

NOTIFICATIONS 

Notifications 
The “Notifications” tab allows you to enable / disable and flexibly configure the conditions for notifications and push 
messages 

 

“Send notifications on reaching” - enable / disable notification functionality 

- The price will reach: “User Level”, “Auto Levels (POC)”, “BigTrade Volume” 

- The volume in the cluster is equal to or more than the values: “Full”, “Delta”, “Buy”, “Sell” 

- On High / Low bar clusters, the volume is equal to or less than the value 

- The vertical volume in a period of time is equal to or more than the value: “Full”; “Delta” as well as the Cluster 
volume (equal to or more). 

- The presence of Divergence, as well as the Cluster volume (equal to or more). 

 

Selecting the type of notification: “Own notifications” and notifications via the MT terminal “MT Alert”, “MT Email” 
and “MT Push”, as well as the Test button to check. 
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Section 5. Work with the schedule 
Using the hot key Ctrl + F8, you can clear the chart from various indicators and the grid - a clean chart, 

pressing again returns everything to its place. 

 

Context menu 
 

The context menu is called with the right mouse button on the chart. For Forex mode and for BO mode, these menus 
differ slightly. 

Forex Mode BO Mode 
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Using this menu you can: 

1. Set limit options at the level where RMB clicked and opened the context menu (Only in BO mode). 

2. Enable / disable the Ask level. 

3. Enable / disable the background display of the cluster. 

4. Enable / disable the display of body / shadow bars. 

5. Enable / disable the display of digital values in clusters. 

6. Enable / disable the display of digital values in a vertical profile. 

7. Enable / disable the display of digital values in a horizontal profile. 

8. Enable / disable graphical display of volume in clusters. 

9. Enable / disable the display of the beginning of the main trading sessions (Asian, European, American) 

10. Enable / disable the display of relevant indicators. 

11. Enable / disable notifications 

12. Enable / disable the display of an additional grid at a price in increments of 10, 20, 50 pips. 

13. Change the display mode of the levels. 

14. Set the User level completely horizontally or from the current time. 

15. Set the User zone (by the shadows of the candles) from the current time. 

16. Clear all levels 

17. Enable / disable auto profiles. 

18. Template selection. 

19. The choice of Workplace. 

Workplaces are an extended variation of the template. In addition to colors and indicators, using workplace, you can 
apply multi-view modes, timeframe values, multiplier values and other parameters of the chart window of the 
currency pair whose workplace you are applying. In the list of workplaces - only those pairs that are currently open 
are displayed.   
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Auto-profile (Авто-профиль)  
In DeltaRiver it is possible to enable the calculation of auto profiles with ranges above the selected timeframe. For 
example: 

Timeframe М1 Timeframe М5 Timeframe М15 Timeframe H1 

 

 

 

 

 

Here is an example of how auto profiles look on the M15 timeframe with the choice of the H1 auto profile.  

 

You can read more about profile parameters in the "Local profile" «Local profile» section. 
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Scaling 
 

Vertical scaling is performed: 

- Ctrl + Left mouse button is clamped on the price scale and drag up / down 

- Shift + mouse wheel anywhere on the chart 

 

Horizontal scaling is performed: 

- Ctrl + Left mouse button is clamped on the timeline and drag left / right 

- Ctrl + mouse wheel anywhere on the chart 

Anywhere on the chart, scrolling the mouse wheel changes proportionally both horizontally and vertically. 

 

Resetting the scale (bringing to the default values) - left-clicking in the lower right corner of the chart 

The size of the numbers in the clusters is selected automatically, but if the cluster size is not enough for display (in 
height or in length), then the numbers are not displayed - in order to display the numbers, you need to scale the size 
in the above ways. 
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Go to a specific date / time 
To go to a specific point in your trading history, you need to:  

1. Click on the date-time of the last bar.  

2. In the window that appears, enter the date / time to which you want to go   
3. Click the Go to button.  

Please note that in Delta River uses UTC-0, so keep this in mind when you enter the date / time in the transition 
window.  
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Basement Indicators 
A number of indicators (RSI, CCI, Stochastic and ATR) have been added to DeltaRiver. You will find instructions on 
how to set up the display, the period of these indicators in the «indicators» section 

To enable the display of "basement" indicators:  

1. You must click the "Indicators" button. This button is located under the horizontal profile in the lower left 
corner.  

 
2. Select the required indicator from the list.  

 

The following information is displayed below the indicator:  

1) Indicator name (in this example CCI) 
2) The period for calculating the indicator (in this example 14) 
3) Method for calculating the indicator 
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